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LICENSE AGREEMENT 

INSTALLING OR USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR ACCEPTANCE OF THE 
FOLLOWING TERMS AND CONDITIONS. IF YOU DO NOT ACCEPT THESE TERMS, YOU MAY NOT 
INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY UNINSTALL THE SOFTWARE OR 
RETURN THE SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT. 
 
GRANT OF LICENSE: 
This is a legal agreement between you, the end-user (either an individual or an entity, "You"), and 
TOSHIBA TEC Corporation ("TTEC")(Unless otherwise separately agreed between you and TTEC or its 
suppliers.). This software, fonts (including their typefaces) and related documentation (Collectively, 
"Software") is licensed under terms and conditions in this License Agreement. You may use Software 
installed on your own electronic device (including but not limited to a laptop computer, a notebook 
computer, a tablet computer, a smartphone) in a network environment which your own electronic device is 
connected to and communicates with a TTEC MFP ("System") in accordance with the terms and 
conditions contained in this License Agreement.  The copyright and any other intellectual property rights, 
title and ownership of Software is proprietary and belonging to TTEC and/or its suppliers. TTEC disclaim 
responsibility for the installation and/or use of Software, and for the results obtained by using Software. 
You may use one copy of Software in the System as installed on a single electronic device, and may not 
copy Software for any reason except as necessary to use Software on a single electronic device. Any 
copies of Software shall be subject to the terms and conditions of this License Agreement. You may not, 
nor cause or permit any third party to, modify, adapt, merge, translate, reverse compile, reverse assemble, 
or reverse engineer Software. You may use Software, only in accordance with this License Agreement. 
The title and intellectual property rights in and to Software will remain the exclusive property of TOSHIBA 
TEC and/or its suppliers, and You will not acquire any rights to Software, except the license expressly set 
forth herein. You may not use, have access to source code of Software. You may not perform 
modification, deletion, or any act to the copyright notice of Software (including its copies).You will be held 
legally responsible for any copyright infringement, unauthorized transfer, reproduction or use of Software.  
 
TERM AND TERMINATION: 
This License Agreement is effective until terminated by TTEC at its discretion or upon your failure to 
comply with any term of this License Agreement. Upon termination, You agree to uninstall, return or 
destroy Software including all copies of Software. In addition to the above, You may terminate this 
License Agreement at any time by uninstalling, returning or destroying Software and all copies. 
 
DISCLAIMER: 
Software is provided "AS IS" without warranty of any kind, either express or implied, including, but not 
limited to, the  warranties of merchantability, fitness for a particular purpose, title, and non-infringement. 
TTEC disclaims any warranty relating to the quality and performance of Software. If Software proves 
defective, You (and not TTEC) shall be responsible for the entire cost of all necessary repair, modification, 
or servicing. TTEC does not warrant that the functions contained in Software will meet your requirements 
or that the operation of Software will be uninterrupted or error free or that Software will have no defects. 
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UPDATE AND DISCONTINUE 
TTEC may update, upgrade and discontinue Software without any restriction. 
 
THIRD PARTY SOFTWARE 
There are cases in which third party software is contained in Software (including future updated and 
upgraded versions). Such third party software is provided to You on different terms and conditions from 
those of this License Agreement. The use of such third party software is subject to agreements or readme 
files (or files similar to readme files) provided separately from this License Agreement ("Separate 
Agreements, etc."). When You use the third party software, You must comply with the terms and 
conditions of the third party software stated in the Separate Agreements, etc.  
 
LIMITATION OF LIABILITY: 
IN NO EVENT WILL TTEC BE LIABLE TO YOU NOR ANY THIRD PARTY FOR ANY DAMAGES, 
WHETHER IN CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR DEATH 
RESULTING FROM GROSS NEGLIGENCE OF TTEC), INCLUDING WITHOUT LIMITATION ANY LOST 
PROFITS, LOST DATA, LOST SAVINGS OR OTHER INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SOFTWARE, EVEN IF TTEC OR ITS 
SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
 
U.S. GOVERNMENT RESTRICTED RIGHTS: 
The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. 
Government is subject to restrictions set forth in subdivision (b)(3)(ii) or (c)(1)(ii) of the Rights in Technical 
Data and Computer Software Clause set forth in DFARS 252.227-7013, or DFARS 52.227-19 (c)(2), as 
appropriate.  
 
GENERAL: 
You may not sublicense, lease, rent, assign or transfer this license or Software. Any attempt to sublicense, 
lease, rent, assign or transfer any of the rights, duties or obligations hereunder shall be null and void. You 
agree that you do not intend to, and will not ship, transmit, export or re-export (directly or indirectly) 
Software, including any copies of Software, or any technical information contained in Software or its 
media, or any direct product thereof, to any country or destination prohibited by government  of Japan, 
the United States and the relevant country. This license shall be governed by the laws of Japan or, at the 
election of a Supplier of TTEC concerned with a dispute arising from or relating to this Agreement, the 
laws of the Country designated from time to time by the relevant Supplier of TTEC. If any provision or 
portion of this License Agreement shall be found to be illegal, invalid or unenforceable, the remaining 
provisions or portions shall remain in full force and effect. 
 
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT YOU 
UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. 
YOU FURTHER AGREE THAT THIS LICENSE AGREEMENT CONSTITUTES THE ENTIRE 
AGREEMENT BETWEEN YOU AND TTEC AND ITS SUPPLIERS AND SUPERSEDES ANY 
PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, OR ANY OTHER COMMUNICATION 
RELATING TO THE SUBJECT MATTER OF THIS LICENSE AGREEMENT. 
 
Contractor/Manufacturer is TOSHIBA TEC Corporation, 1-11-1, Osaki, Shinagawa-ku, Tokyo, 141-8562, 
Japan 
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TRADEMARKS AND COPYRIGHT 

Trademarks 

e-STUDIO, e-BRIDGE, TopAccess are trademarks of Toshiba Tec Corporation. 
All other product names and logos are trade and service marks of their respective companies. 
 

Copyright  

Copyright©2011-2018 TOSHIBA TEC CORPORATION, All Rights Reserved. 
Under the copyright laws, this manual cannot be reproduced in any form without prior written permission 
of TTEC. 
 

Disclaimer 

The following notice sets out the exclusions and limitations of liability of TOSHIBA TEC CORPORATION 
(Including its employees, agents and sub-contractors) to any purchaser or user (‘User’) of the  
e-BRIDGE Role Manager including its accessories, options and bundled software (‘Product’). 
 
1. The exclusion and limitations of liability referred to in this notice shall be effective to the fullest extent 
permissible at law. For the avoidance of doubt, nothing in this notice shall be taken to exclude or limit 
TOSHIBA TEC CORPORATION’s liability for death or personal injury caused by TOSHIBA TEC 
CORPORATION’s negligence or TOSHIBA TEC CORPORATION‘s fraudulent misrepresentation. 
 
2. All warranties, conditions and other terms implied by law are, to the fullest extent permitted by law, 
excluded and no such implied warranties are given or apply in relation to the Products. 
 
3. TOSHIBA TEC CORPORATION shall not be liable for any loss, cost, expense, claim or damage 
whatsoever caused by any of the following: (a)use or handling of the Product otherwise than in 
accordance with the manuals, including but not limited to Operator’s Manual, User‘s Guide, and/or 
incorrect or careless handling or use of the Product; (b)any cause which prevents the Product from 
operating or functioning correctly which arises from or is attributable to either acts, omissions, events or 
accidents beyond the reasonable control of TOSHIBA TEC CORPORATION including without limitation 
acts of God, war, riot, civil commotion, malicious or deliberate damage, fire, flood, or storm, natural 
calamity, earthquakes, abnormal voltage or other disasters; (c)additions, modifications, disassembly, 
transportation, or repairs by any person other than service technicians authorized by TOSHIBA TEC 
CORPORATION; or (d)use of paper, supplies or parts other than those recommended by TOSHIBA TEC 
CORPORATION. 4. Subject to paragraph 1, TOSHIBA TEC CORPORATION shall not be liable to 
Customer for: (a)loss of profits; loss of sales or turnover; loss of or damage to reputation; loss of 
production; loss of anticipated savings; loss of goodwill or business opportunities; loss of customers; loss 
of, or loss of use of, any software or data; loss under or in relation to any contract; or (b)any special, 
incidental, consequential or indirect loss or damage, costs, expenses, financial loss or claims for 
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consequential compensation whatsoever and howsoever caused which arise out of or in connection with 
the Product or the use or handling of the Product even if TOSHIBA TEC CORPORATION is advised of 
the possibility of such damages. TOSHIBA TEC CORPORATION shall not be liable for any loss, cost, 
expense, claim or damage caused by any inability to use (including, but not limited to failure, malfunction, 
hang-up, virus infection or other problems) which arises from use of the Product with hardware, goods or 
software which TOSHIBA TEC CORPORATION has not directly or indirectly supplied. 
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SECURITY PRECAUTIONS 

In order to correctly utilize the product’s security features, be sure to take the following 
precautions.  To avoid physical security problems such as hardware removal or 
inappropriate disassembly, please take appropriate security measures including 
monitoring persons entering and leaving the site. 
 
When connecting this product with an outer network such as the Internet, make sure the 
network environment is protected by a firewall, and that communication occurs over 
secure channel (such as SSL) to prevent information from being leaked resulting from 
incorrect settings, and to avoid illegal access by unauthorized users.  
 
To prevent the unauthorized change in configuration settings, make sure the default 
administrator password is changed before using this product. For further protection, the 
administrator password should be changed periodically. 
 
e-BRIDGE Role Manager does not provide separate security controls; it leverages 
existing operating system and network security settings. 
 
When exported Role Data to file with this software, the PIN code data which was 
entering or modification on user interface of this software be written to file without 
encode. To export the encoded PIN code data to file, please export to file by using 
TopAccess after deployed via the network to the MFP once. 
 
When operating a computer in which this software is installed, be sure to install antivirus 
software to prevent a virus infecting the system. Basically, develop an antivirus 
countermeasure in accordance with the user's guidelines. The following actions are 
recommended in the system operation. 
(1) Be sure to install virus detection software in the system and let it be operated all of 
the time. 
(2) Be sure to upgrade virus detection data so that they are latest ones all of the time. 
(3) It is recommended to perform virus detection for all data in the computer regularly. 
(4) When a virus is detected, immediately physically disconnect the computer from the 
network and take an appropriate countermeasure to avoid secondary infection.     
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When the security patch is applied to the computer in which this software is installed, 
follow the user's guidelines. 
Rebooting of the OS may be required when some security patches are applied. In this 
case, distribution of documents is not available during rebooting. Therefore, pay 
attention to the timing of the application. 
 
Be sure to understand the security policy and its procedure in your organization, and 
manage and operate this software and external devices according to the policy after first 
reading the operator's manual. Then explain the security instructions to general users 
who are authorized to use this software to let them conform to the security rule. 
 
Provide general users with the appropriate privilege of using this software and keep 
supervising its correct operation. 
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INTRODUCTION  

Intended Audience for this Document  

This document is intended for the Toshiba Service Technician or company administrator 

in charge of managing Toshiba MFPs on the network.  It is assumed that the 

administrator currently uses TopAccess to manage the MFPs and has administrator 

privileges on the MFP.  The administrator must be familiar with exporting data from 

existing MFPs using TopAccess.  The administrator will be required to provide the MFP 

Administrator passwords when deploying to the MFP on the network. This document 

also assumes the administrator is familiar with the type of data associated with MFP 

users, user attributes, MFP roles, and role attributes. 

In addition to this document, please review the README, End User License Agreement, 

and Software License Information. These documents can be found in the en-US folder of 

the installed folder.  

What is e-BRIDGE Role Manager? 

e-BRIDGE Role Manager is a software that helps an administrator migrate MFP user 

data and role data from one Toshiba MFP to a networked fleet of Toshiba MFPs in a 

simplified manner.   There are two types of data managed in e-BRIDGE Role Manager, 

user data and role data.   

 

 

 
CHAPTER 
1 

INTRODUCTION 



  
 
 

  

11 
 

e-BRIDGE Role Manager V 1.14 
Service Technician & Administrator Guide 

User data is all information associated with MFP User Name including the password, 

authentication type, quotas, as well as department, group, and role assignments.            

This data can be imported into e-BRIDGE Role Manager as well as created using               

e-BRIDGE Role Manager.   

Role data is the set of role names and associated MFP permissions which can be 

assigned to users, groups, or LDAP Server entities.  This data can be imported into            

e-BRIDGE Role Manager as well as created using e-BRIDGE Role Manager.   

The most typical use of e-BRIDGE Role Manager is to port existing MFP data to a fleet 

of new MFPs.  This workflow is illustrated in the final chapter in this document Real 

World Example – Porting Data from an existing MFP to an Upgraded MFP 

Environment.   

e-BRIDGE Role manager is also useful for adding new employee data or editing 

existing employee data to be deployed to a fleet of the MFPs.  

e-BRIDGE Role Manager Installation 

e-BRIDGE Role Manager is installed using e-BRIDGE Role Manager Setup Wizard.  To 

begin installation, double click Setup.exe from e-BRIDGE Role Manager Installation 

media. 

Minimum Hardware Requirement 

 CPU:Pentium 4 , 2 GHz, 2.5 GHz recommended  

 RAM: 2 GB, 4 GB recommended  

 HDD: 40 GB  

 Graphics card: SVGA-compatible, hardware support for DirectX 9.0 & Pixel 

Shader 2.0 is recommended 
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Minimum Software System Requirements 

 Operating System 

 Windows 7 Professional/Enterprise/Ultimate SP1 x32 and x64 

 Microsoft Windows 8.1 Professional/Enterprise x32 and x64 

 Microsoft Windows 10 Pro/Enterprise x32 and x64 

 Windows Server 2008 Standard/Enterprise/Datacenter SP2 x32 and x64 

 Windows Server 2008 R2  Foundation/Standard/Datacenter/Enterprise x64 

 Windows Server 2012 Foundation/Standard/Datacenter/Essentials x64 

 Windows Server 2012  R2 Standard/Datacenter/Essentials x64 

 Windows Server 2016 Standard/Datacenter/Essentials x64 

NOTE. INSTALLING THIS SOFTWARE IN AN OS IN WHICH USER ACCOUNT CONTROL IS ENABLED 

WHEN USER ACCOUNT CONTROL IS ENABLED, RIGHT-CLICK AND SELECT "RUN AS 

ADMINISTRATOR" TO PERFORM THE INSTALLER OF THIS SOFTWARE. 

Target MFP Models 

 e-STUDIO4540C Series 

 e-STUDIO6550C Series 

 e-STUDIO456 Series 

 e-STUDIO856 Series 

 e-STUDIO306LP 

 e-STUDIO6570C Series 

 e-STUDIO507 Series  

 e-STUDIO857 Series  

 e-STUDIO307LP 

 e-STUDIO5055C Series 

 e-STUDIO2550C Series SSD model 

 e-STUDIO2550C Series HDD model 
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 e-STUDIO2551C Series 

 e-STUDIO407CS Series 

 e-STUDIO527S Series 

 e-STUDIO5005AC Series 

 e-STUDIO2500AC Series 

 e-STUDIO5008A Series 

 e-STUDIO7506AC Series 

 e-STUDIO8508A Series  

 e-STUDIO5008LP Series 

 e-STUDIO5015AC Series 

 e-STUDIO2510AC Series 

 e-STUDIO5018A Series 

 e-STUDIO7516AC Series 

 e-STUDIO8518A Series  

 GA-1211-EX 

 GA-1310-EX 

Please check with your Toshiba dealer to confirm that your Toshiba MFP model and 
firmware are compatible with e-BRIDGE Role Manager.  

 

Installing Language and Culture-Specific version of e-BRIDGE Role Manager 

To fully experience the language and culture-specific versions of e-BRIDGE Role 

Manager, you must do the following: 

1. Install and use e-BRIDGE Role Manager on Microsoft Windows OS that has 

the respective language packs and Input Method Editors (IME) installed and 

enabled; 

2. Install the appropriate Microsoft .NET Framework language pack from the link 

below after installing e-BRIDGE Role Manager.  



  
 
 

  

14 
 

e-BRIDGE Role Manager V 1.14 
Service Technician & Administrator Guide 

Microsoft .NET Framework language packs can be downloaded from the following location. To download the 

language pack, first select the language and then press "Change" to switch to the specific download page. 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=7A4C6414-7F64-47A5-AE20-218403137957 

  

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=7A4C6414-7F64-47A5-AE20-218403137957
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Upgrading from Previous Versions of e-BRIDGE Role Manager 

If you are upgrading from a previous version of e-BRIDGE Role Manager, you must first 

uninstall the current version. You can uninstall the current version of e-BRIDGE Role 

Manager using Windows Control Panel option or by selecting the Uninstall option from  

e-BRIDGE Role Manager Setup program. 

Uninstalling e-BRIDGE Role Manager 

e-BRIDGE Role Manager can be uninstalled using the Setup.exe or through Windows 

Control Panel option. Uninstalling e-BRIDGE Role manager will not remove any of the 

project files from your system nor will it remove Microsoft .NET Framework. 
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WORKING WITH PROJECTS 

e-BRIDGE Role Manager application organizes your work by projects.  When you 

launch e-BRIDGE Role Manager you will be prompted1 to either create a new project or 

open an existing project.   Unlike other project based software, e-BRIDGE Role 

Manager saves your data automatically and you will never have to explicitly save your 

project file.   This worry free environment allows you to exit the application at anytime 

and return to your project later to continue working without the loss of data.   

Steps to Start a New Project: 

 

 

When you launch e-BRIDGE 

Role Manager, select New 

Project from the Start Window 

 

Figure 1. Start Window 

                                            
If this is the very first time you launch the e-BRIDGE Role Manager after installation, you will also be 
prompted to select a language.  On certain non-English OS you may also need to restart the application 
in order to continue in that language. 

 
CHAPTER 
2 

WORKING WITH 
PROJECTS 



  
 
 

  

17 
 

e-BRIDGE Role Manager V 1.14 
Service Technician & Administrator Guide 

 

From the New Project Dialog, 

Enter a Unique Project Name 

 

To change the location or 

path of the project, click the 

Select Button 

 

Create a project file password 

to protect your project data.   

 

Click the OK button to 

continue and start work. 

 

 

Figure 2. New Project Dialog 

 

 

 

 

 

 

TIP 

It is highly recommended that you create a password to be associated with the 

project file to protect sensitive data.  Once created, you will be prompted to 

provide the password when opening the project in e-BRIDGE Role Manager.   
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e-BRIDGE Role Manager Layout  

When you open a project, you will notice the tab layout used to organize e-BRIDGE 

Role Manager Functions.    The Project Menu contains global project- based commands 

used to create a new project, open a project, save a project, import project data, and 

exit            e-BRIDGE Role Manager. 

 

 

User Management Tab.   Contains 

functions to create, edit, delete and sort 

Users and User Groups. 

 

Role Management Tab.  Contains 

functions to create, edit, delete and Set 

Default Roles and manage LDAP role 

mapping functions. 

 

Deployment Tab.  Contains functions to 

discover the MFP and deploy the Role 

data to the selected fleet. 

 

Settings Tab. Contains functions to 

change the project password. 

 

ODCA Settings. Contains settings to 

connect with the MFP while importing 

and deploying 

 
 

Figure 3. e-BRIDGE Role Manager Tab Layout 
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e-BRIDGE Role Manager  

Project Menu  

 

 

 

 

 

 e-BRIDGE Role Manager shall not 

encrypt the PinCode while exporting to 

XML file.  

 
Figure 4. e-BRIDGE Role Manager Project Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE. 

 THE XML FILE EXPORTED FROM E-BRIDGE ROLE MANAGER CAN ONLY BE IMPORTED VIA TOP 

ACCESS IN TO THE TARGET MFP.  

 THE XML FILE EXPORTED FROM E-BRIDGE ROLE MANAGER CANNOT BE IMPORTED BACK IN TO 

E-BRIDGE ROLE MANAGER USING IMPORT ROLE DATA FROM FILE OPTION.  

 PLEASE USE THE IMPORT FUNCTION OF TOPACCESS FOR IMPORTING TO MFP. 
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IMPORTING ROLE DATA  

Once you have created a project, the next step is to import existing role and user data.  

There are two ways to import data into e-BRIDGE Role Manager; directly from the MFP 

(Network Import) or by importing a data file that has been previously exported from the 

MFP (File Import).  The method you can use partly depends on the model of the MFP 

you want to import from.   

Network Import is available if importing from the following MFP Models:  

 e-STUDIO4540C Series 

 e-STUDIO6550C Series 

 e-STUDIO456 Series 

 e-STUDIO856 Series 

 e-STUDIO306LP 

 e-STUDIO6570C Series 

 e-STUDIO507 Series  

 e-STUDIO857 Series  

 e-STUDIO307LP 

 e-STUDIO5055C Series 

 e-STUDIO2550C Series SSD model 

 e-STUDIO2550C Series HDD model 

 e-STUDIO2551C Series 

 e-STUDIO407CS Series 

 e-STUDIO527S Series 

 e-STUDIO5005AC Series 

 
CHAPTER 
3 

IMPORTING Role 
DATA 
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 e-STUDIO2500AC Series 

 e-STUDIO5008A Series 

 e-STUDIO7506AC Series 

 e-STUDIO8508A Series 

 e-STUDIO5008LP Series 

 e-STUDIO5015AC Series 

 e-STUDIO2510AC Series 

 e-STUDIO5018A Series 

 e-STUDIO7516AC Series 

 e-STUDIO8518A Series 

 GA-1211-EX 

 GA-1310-EX 
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Importing Data Directly from the MFP (Network Import) 

If you are importing e-BRIDGE Role Manager Data from the MFP, you can use the 

network import method.  With this method, you can point to the MFP on the network to 

import the data directly. This operation will import both user data and role data 

simultaneously. 

Steps to import Role data from a MFP: 

 

From the e-BRIDGE Role  

Manager Project Menu, select the 

Import Role Data From MFP 

menu item. 

 

 

Figure 5. Import Role Data From MFP Menu 
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Enter the MFP Name or IP 

Range and click the search 

button. 

                                              

 

 

 

 

 

 

 

 

 

 

 

 

       
 

Figure 6. Import from MFP Dialog 

 

 
NOTE. 

 TO SEARCH WITHIN A RANGE OF IP ADDRESSES, ENTER A ‘- ‘BETWEEN THE “START” AND 

“END” ADDRESS (E.G.: 10.1.10.10-10.1.255.255). 

 TO SEARCH WITH MULTIPLE IP ADDRESSES, ENTER A “;”( SEMI-COLON) AFTER EACH 

ADDRESS (E.G.: 10.1.10.10;10.1.255.255).  
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Select the MFP from which 

you want to import. 

 

Enter the Administrator 

User Name and Password 

corresponding to the 

selected MFP. 

 

Check the Role or Group 

checkboxes for overwriting 

Role or Group data in case 

of same name. 

 

Click the OK button to begin 

data import. 

 

 

Figure 7. Import from MFP Dialog –Selecting MFP 

 



  
 
 

  

25 
 

e-BRIDGE Role Manager V 1.14 
Service Technician & Administrator Guide 

Importing Data from a File 

If you are importing Role data using the File Import method, you must import two files, 

one that contains the role data (Role Data or Role + User + Group Data) and one that 

contains the user data (User Data).  These files must have been first exported from the 

MFP via TopAccess.  When importing data files, you must first import Role Data 

before you import User Data.  Failing to import in the correct order will result in 

import errors. 

 

File Content Data File exported from TopAccess File Format  

Role Data  
Contains role data including mappings to LDAP 

server if any exist. 
XML   

User Data Contains all of the user properties CSV   

Role + User + 

Group Data 
Contains role data, user properties and group data XML 

LDAP Role 

Mapping 
Contains LDAP server mappings XML 
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Following table shows the supported File Content by e-BRIDGE Role Manager for 

various MFP Models 

MFP Models User Data 

(CSV) 

Role Data 

(XML) 

Role + User + 

Group (XML) 

LDAP Role 

Mapping 

(XML) 

e-STUDIO4540C Series     

e-STUDIO6550C  Series     

e-STUDIO456 Series     

e-STUDIO856 Series     

e-STUDIO306LP     

e-STUDIO6570C Series     

e-STUDIO507 Series     

e-STUDIO857 Series     

e-STUDIO307LP     

e-STUDIO5055C Series     

e-STUDIO2550C Series SSD 

model 
    

e-STUDIO2550C Series HDD 

model 
    

e-STUDIO 2551C Series     

e-STUDIO407CS Series     

e-STUDIO527S Series     

e-STUDIO5005AC Series     

e-STUDIO2500AC Series     

e-STUDIO5008A Series     

e-STUDIO7506AC Series     

e-STUDIO8508A Series     

e-STUDIO5008LP Series     

e-STUDIO5015AC Series     

e-STUDIO2510AC Series     

e-STUDIO5018A Series     

e-STUDIO7516AC Series     
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    - Not applicable in this model of MFPs 

   - Supported in this model of MFPs



  

e-STUDIO8518A Series     

All other Models     
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Steps to Import Role Data from a File: 

 

Select the Import Role 

Data From File… menu 

item to invoke the Windows 

File Open dialog. 

 

 

Figure 8. Import Role Data From File Menu Item 
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From the File Open dialog, 

select the .xml file 

containing the role data 

previously exported from 

TopAccess. 

 

Figure 9. File Open Dialog for Role Data (xml file)  

 

 

 

 

Check the Role or Group 

checkboxes to overwrite 

each data if same name. 

 

 

Figure 10. Overwrite Roles/Groups window 
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For e-STUDIO4540C,  

e-STUDIO6550C, 

e-STUDIO2550C/2551C, 

MFP Models,  

After importing the Role + 

User + Group data file, a 

popup will be shown for 

importing LDAP Role 

Mapping file.   

 

 

Figure 11. LDAP Role Map File Import Confirmation Popup 
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Steps to import User Data from a File: 

 

From the e-BRIDGE 

Role Manager Project 

Menu, select the Import 

User Data From File… 

menu item to invoke the 

Windows File Open 

dialog. 

 

 

 

Figure 12. Import User Data From File Menu 

From the File Open 

dialog, select the .csv file 

containing the user data 

previously exported from 

TopAccess. 

 

 

Figure 13. Import User Data from File File Open 

Dialog 
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Select an encoding for 

importing the CSV File. 

For E.g. If the CSV file 

contains user name with 

European special 

characters select 

“Western Europe” or 

“Eastern Europe” 

encoding. 

 

 

  

Figure 14. Select CSV Encoding 

 

NOTE. IF WRONG ENCODING IS SELECTED WHILE IMPORTING THE CSV FILE, THE IMPORTED 

DATA MAY BE INVALID OR CORRUPT. PLEASE IMPORT AGAIN BY SELECTING CORRECT 

ENCODING. 
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EDITING ROLE DATA  

The e-BRIDGE Role Manager application represents data in terms of Users, Groups, 

and Roles, all of which are displayed in lists.   Users, Groups, and Roles, can all be 

created, sorted and deleted using the associated menu.   

User Management  

The User Management Tab contains the list of MFP Users and Groups and their 

corresponding editable properties.  The User Menu allows you to complete user-specific 

tasks and the Group Menu allows you to complete group-specific tasks.   

Default Users and Groups 

There are two default Groups in the Group list that cannot be deleted:  All Members 

and Unassigned Members.   All Members contains the complete list of Users 

regardless of Group membership.  Unassigned Members contains the list of Users who 

are not assigned to any Group; this helps determine those users that are ‘left over’ 

when assigning Group membership.   

e-BRIDGE Role Manager contains the default Users that cannot be deleted.  The 

following properties of a default User cannot be edited.  

 User Name 

 Authentication Method (Local) 

 Role Assignments 

 Group Assignments. 

 
CHAPTER 
4 

EDITING Role DATA 
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The User Management Tab   

 

 

 

 

 

Select a Group 

 

The list of users within that 

group is shown  

The Group’s editable properties 

are shown.   

       GroupMenu           Usermenu

 

Figure 15.  User Management Tab with Selected Group 

 

 

 

 

 

Select a User 

 

The User’s editable properties 

are shown. 

 

Figure 16.  User Management Tab with Selected User 
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Role Management 

The Role Management Tab contains the list of MFP Roles and their corresponding 

editable properties.  The Role Menu allows you to complete role-specific tasks. 

Default Roles 

e-BRIDGE Role Manager contains 14 default Roles that cannot be deleted.  You cannot 

edit the permissions associated with a default Role. 

 

The Role Management Tab  

 

 

 

 

 

 

 

 

 

Select a Role  

 

The Role’s editable 

properties are shown. 

           Role Menu 

 

Figure 17.   Role Management Tab with Selected Role 
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Creating and Editing Users 

Though you will likely import your initial user list (see Importing Users), e-BRIDGE Role 

Manager provides an easy way of creating new users and editing existing user’s 

properties.   

Steps to create a New User: 

Select New User from the 

Users Menu to invoke the 

New User Edit Panel 

 

 

Figure 18.   New User Menu Item 

 



  
 
 

  

37 
 

e-BRIDGE Role Manager V 1.14 
Service Technician & Administrator Guide 

 

When creating a new user, a 

popup will be displayed with 

a textbox showing an auto 

generated User ID. This User 

ID can also be edited. The ID 

given in this window will be 

set as the User ID for the 

newly created user.      

Numeric character up to 

10,000 can only be entered 

for User ID.                  

 

Figure 19.  Popup for UserID 

Enter the required 

information (User Name 

and Password are the only 

required items) to create a 

New User 

Click the Save button to 

close the Edit Panel. 

Please enter characters into 

the input fields which are 

supported by the MFP in 

use. 

 
 

Figure 20.  New User Panel 
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If you are going to be creating a lot of users, select the Save button dropdown option of 

Save & New or Save & New Keep Settings 

 

 

 Save.  The save button will save the newly created User and close User Edit Panel. 

 Save & New.  The Save & New option does not close the User Edit Panel.  Rather, it 

saves the information entered and clears the fields so that you can create another new 

user. 

 Save & New Keep Settings.  The Save & New Keep Settings option does not close 

the User Edit Panel.  It saves the information entered and clears only the User Name 

and Password fields so that you can create another new user with the same default 

properties as the one previously created.  This saves editing time if you want to create 

a lot of users with the same permissions and group affiliation. 

 

  

TIP 
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Steps to Edit an Existing User: 

 

From the User list, select 

the User you want to edit 

and click the Edit button to 

invoke the User Edit Panel 

 

Figure 21. User Properties 

 

 

Change any of the editable 

properties.   

Click the Save button to 

save the changes and  

close the Edit Panel. 

 

Figure 22. User Properties Panel in Edit Mode 
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Steps to sort Users: 

 

  

Sorting Users 

 By default users are 

sorted with ID ascending. 

Option for sorting the 

users both with ID and 

Name is available. 

 

 

Figure 23. Sorting of Users 
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Creating and Editing Groups 

Groups serve as containers to help to organize users.  Up to 30 groups can be created.     

Steps to Create a New Group: 

 

 

Select New Group from the 

Group Menu.  

 

 

Figure 24.  New Group Menu item 

 

 

Enter a Group Name  

 

Select the roles you want to 

assign to the group’s members. 

 

Click the Save Button to close 

the Edit Panel and save the 

group information. 

 

Figure 25.  New Group Panel 
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Figure 26.  Group Properties 

  

  

 

 

 

 

 

 

 

 

 

TIP 

You’ll notice that by default, the newly created group does not contain any users.   
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Steps to Move Users from One Group into Another: 

Select the User(s) that you 

want to move. 

 

Click the Move To item 

from the Users Menu. 

 

Select the target group in 

the menu.  The selected 

users will be moved to the 

target group. 

 
 

Figure 27.  Move To Menu 

  

 

Users can belong to 30 groups.  If a user is already a member of 30 groups, the Move 

To menu will be disabled.  You can assign additional group membership by first 

removing the user from one of its groups.   

NOTE. YOU CAN ALSO CHANGE GROUP MEMBERSHIP FROM THE USER PROPERTIES PANEL IN THE 

USER MANAGEMENT TAB. 
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Steps to Edit an Existing Group: 

From the Group list, select 

the group you want to edit 

and click the Edit button to 

invoke the Group Edit  

Panel. 

 

Figure 28. Group Properties 

 

Change the Group Name or 

check/uncheck Role 

Assignments. 

Click the Save button to 

save the changes close the 

Edit Panel. 

 

Figure 29. Group Properties Panel in Edit Mode 
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Creating and Editing Roles 

A Role is a group of permissions that can be associated with a user, a group, or an 

LDAP Entity.  You can map both initial roles and user-defined roles to entities on you 

LDAP server.    

There is always one and only one Default Role in e-BRIDGE Role Manager.  The 

Default Role is the role that is assigned to all users who do not have a role explicitly 

assigned to them.  The initial role is the User role.    

 

Steps to Create a New Role:  

 

 

 

Select New Role from the Role 

Menu. 

 

Figure 30. New Role Menu 
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Enter Role Name and select the 

appropriate permissions. 

 

Select a role from the Based on 

dropdown to preselect a list of 

permissions. 

 

Click Save to close the Edit 

Panel. 

 

Figure 31. New Role Panel 
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Steps to Edit an Existing Role: 

 

 

Select the role from the role list 

that you want to edit and click the 

Edit button to invoke the Edit 

Panel.   

 

 

 

 

Figure 32. Role Edit Button 

 

Check or Uncheck from the 

Permissions list and click the 

Save button to close the Edit 

Panel. 

 

Figure 33. Role Save Button 
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Steps to Map Roles to Directory Server Entities: 

You can map a role to LDAP entities at the time you are creating a role or when you are 

editing a role.   

 

Select the role in the Role list 

that you want to map to an 

LDAP entity. 

 

 

From the Directory Server 

Filter section Enter the 

Property - Value pair as 

found on your LDAP server.  

This pairing will be 

associated with the role you 

are editing/creating. 
 

Figure 34. Role Panel - Edit Mode 
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Click the And link to get an 

additional Property – Value 

pair.  You can create up to 50 

pairings.  Note that the 

pairings are based on the 

“and” operator; therefore 

each Property name must be 

unique. 

 

Figure 35. Role Panel with Directory Server Filters 
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Steps to Change the Default Role: 

Select the role from 

the role list that you 

want to make the 

default role.   

 

 

 

 

Figure 36. Role Management Tab with Role Selected 

Select Default Role 

from the Role Menu.   

As a result, the 

Default Role icon 

will appear next to 

the selected role.  

This role will now be 

associated with 

users that otherwise 

do not have a role 

association. 

 

Figure 37. Default Role Menu 
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DEPLOYING ROLE DATA TO MFPS   

What is Deployed? 

When deploying from the e-BRIDGE Role Manager, all of the user data, group data, 

and role data in the project will be sent to the fleet of target MFPs.  User counter data is 

also deployed only if the Deploy User Counter Information check box in the 

Deployment Tab is checked.   

NOTE:  

DEPLOY USER COUNTER INFORMATION CHECKBOX IS SHOWN ONLY IF COUNTER DATA WAS 

INCLUDED IN THE ROLE FILE IMPORT.   

IF DEPLOY USER COUNTER INFORMATION CHECK BOX IS CHECKED WHEN DEPLOYING, COUNTER 

DATA FOR THE USERS WILL BE OVER WRITTEN FOR EXISTING USERS AND ADDED FOR NEW USERS. 

 

 

 

 

 

 

 

 

 

 
CHAPTER 
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Steps to Create a Deployment Fleet: 

 

From the Deployment Tab enter 

the IP Address of the MFPs you 

want to discover and click the 

Search button to start discovery. 

 

 

 

 Figure 38. IP Address Range for Discovery 

 

 

 

During Discovery, the device list 

will be populated, you can stop 

discovery by clicking the Stop 

Search link at any time.  

  

The MFP Models will be 

highlighted in different colors to 

indicate data loss during 

import/deployment. The data loss 

information will be shown as a tool 

 

 

Figure 39. Deployment Tab - Discovery 
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tip. 

 

 

 

Data Import/Deployment Details 

 Color Import Deployment 

No color 
No data loss or addition in this 

version of MFP. 

No data loss or addition in this 

version of MFP. 

Light Yellow 

Black Quota/Color Quota data 

will not be considered for 

export. 

Black Quota/Color Quota data will not 

be considered for export. 

Light Orange 
MFP version is different. For 

further details contact dealer. 

MFP version is different. For further 

details contact dealer. 

Brown and Italic 

Users/Roles/Groups mapped to 

new permissions (EWBAccess, 

USBDirectPrint) will not be 

supported. 

Users/Roles/Groups mapped to new 

permissions (EWBAccess, 

USBDirectPrint) will not be supported. 

 

 

 

 

 

 



  
 
 

  

54 
 

e-BRIDGE Role Manager V 1.14 
Service Technician & Administrator Guide 

Steps to Deploy Role Data to the Discovered Fleet: 

 

 

 

 

Select MFPs for deployment.  

You will notice that the 

Credentials Panel and the 

Deploy button becomes 

enabled.  

 

  

 

Figure 40. Deployment Tab – MFPs Selected 

 

In the Credentials Panel, enter the 

User Name and Password of the 

target MFP(s). 

 

Make sure to check Deploy User 

Counters to deploy all of the user 

counter data. 

 

Figure 41. Deployment Tab – MFP Credentials 
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Click the Deploy button. 

 

Figure 42. Deployment Tab – Deploy Button 

 

 

 

 

Once Deployment begins, the 

Deployment Status column updates 

dynamically. 

 

 

Figure 43. Deployment Tab - Status 
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Deployment Time and Status 

The time required for deployment depends on the amount of data you are deploying and 

the number of the MFPs in your deployment fleet.  A Deployment Status is given to help 

inform you about the deployment process.   

Deployment Status 

 

Deployment  

Status 

 

Description 

Effect of 

Closing e-

BRIDGE Role 

Manager 

 Queued The system is gathering data and preparing the 

transmission.   

Canceled 

Canceled A queued item was canceled.   No Effect 

 Transmitting The Role data is being sent to the MFP.   Canceled 

Pending All Role data has been received by the MFP and the 

MFP is processing the data.   

No Effect 

 Updated The data was successfully deployed and the MFP 

updated. 

No Effect 

 <Error 

Description > 

Unsuccessful Deployment.  A description will be 

provided when available.  Note that once the data has 

been received by the MFP, errors on the MFP side 

may not be reportable. 

No Effect 

 

 

 

 



  
 
 

  

57 
 

e-BRIDGE Role Manager V 1.14 
Service Technician & Administrator Guide 

Though we cannot provide estimated deployment times, we can report estimated 

transmission times.  Deploying data for 1,000 users to 50 MFPs on an average speed 

network will take up to 5 minutes to transmit.  Once transmission is complete, the MFP 

status will change to Pending.  During the Pending status target MFP(s) will import the 

Role data.  Once the MFP is updated, an Updated status will be returned to e-BRIDGE 

Role Manager. 

If you close the Role Application during a Queued or Transmitting status, that 

deployment will be canceled.  Deployments that show a Pending status will not be 

affected by closing the application.   

Because it may take a long time for the MFPs to return an Updated status, e-BRIDGE 

Role Manager provides a feature that allows you to close the application and return at a 

later time to obtain the final status of the last deployed fleet.  

When you return to the e-BRIDGE Role Manager, the Deployment Tab retains the Last 

View of your deployment status.   The Deployment Results Panel shows the date of 

deployment and the overall status in terms of number of updated, pending, or errors.  If 

one or more deployments have a pending status, a Refresh Status link is shown.  

When you click the Refresh Status link, e-BRIDGE Role Manager will establish 

communication with the MFP to update the Pending Status.   

NOTE: IF YOU INITIATE A NEW DISCOVERY OR DEPLOYMENT, THIS LAST VIEW STATUS WILL BE 

LOST. 

While deploying the data from e-BRIDGE Role Manager, if error message is displayed 

as "Error during deployment" confirm that same PinCode is not assigned to more than 

one user. 
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Deployment Result 

Panel 

 

Refresh Status Link 

Shown only when there 

is at least one MFP 

deployment with a 

Pending status. 

 

Figure 44. Deployment Tab – Last View 
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ODCA SETTINGS 

e-BRIDGE Role Manager uses the ODCA Settings for network import from the MFP and 

Deploying to the MFP.  You can set the values same as that TopAccess ODCA settings. 

 

Figure 45.  ODCA Settings 

 

 

 

If SSL port is enabled, e-BRIDGE Role Manager shall use secure connection to connect 

to the MFP and the SSL certificate of the MFP should be available in your system. 

 
CHAPTER 
6 

ODCA Settings 
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e-BRIDGE Role Manager has default ODCA settings as http port with 49629 and SSL 

port will be disabled 

NOTE: ODCA SETTINGS IN E-BRIDGE ROLE MANAGER SHOULD BE SAME AS SETTINGS IN 

TOPACCESS OF THE MFP. 

Steps to install SSL for secured connection 

 

 

 

 

Login to TopAccess. Click on 

Administrator Tab. Select the 

Security sub menu. Click on 

Certificate management. 

Click Export button.  

 

  

 

Figure 46. Export Certificates 
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On clicking the Export button, a 

Pop-up window will be displayed 

containing Self-Signed Certificate 

in it. Save the certificate in your 

PC and include it as Trusted 

Certificate. 

 

Figure 47. Exporting certificate from 

TopAccess 

 

 

 

 

 

 

 

Open any browser. Click on the 

settings option. Select the Internet 

options option.  

 

 

 

 

 

 

 

Figure 48. Settings - Internet Options 
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On Clicking the internet options, 

Internet Options window will 

open. Click Content in the tab.  

 

Figure 49. Internet Options - Content 

 

 

 

 

 

 

 

Click the Certificates button. 

 

Figure 50. Internet Options - Certificates 
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On Clicking Certificates button. 

You will get this window. 

Click on Import button. 

 

 

Figure 51. Certificates - Import 

 

 

 

 

 

 

 

 

On Clicking Import, this installation 

wizard will open. Click Next button 

in the window. 
 

Figure 52. Import – Installation wizard 
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Click on Browse button. Browse and 

select the downloaded certificate 

and then press next button. 

 

Figure 53. Browse Certificate  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    Click the Next button. 

 

Figure 54. Certificate Installation Wizard 
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Click Finish button in the 

Installation wizard.  

Figure 55. Finish Installation 

 

 

 

 

 

 

 

 

On Clicking Finish, A Pop-up 

showing “The Import was 

successful” will appear. Click OK 

 

Figure 56. Successful Import 
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Once the Pop Up disappears, Click 

on Trusted Root Certification 

Authorities. 

 

Check whether Issued To column 

displays the name of the MFP from 

which you got the certificate for 

installation 

 

 

 

Click Close. After which, 

Certificates window will be closed. 

Click OK in the Internet Options 

window.  

 

Figure 57. MFP Name Check 
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REAL WORLD EXAMPLE - PORTING 

DATA TO AN UPGRADED MFP ENVIRONMENT 

1. Create a Project 

Launch e-BRIDGE Role 

Manager from your 

Windows Start Menu. 
 

Figure 58. e-BRIDGE Role Manager Application in  Start Menu 

  

 

 

 

Select New Project from 

the Start Window. 

 

Figure 59. Start Screen 
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From the New Project 

Dialog, Enter a Unique 

Project Name. 

 

To change the location or 

path of the project, click 

the Select Button. 

 

Create a project file 

password to protect your 

project data.   

 

Click the OK button to 

continue and start work. 

 

 

Figure 60. New Project Dialog 

 

 

It is recommended that you create a password to be associated with the project file to 

protect sensitive data.  Once created, you will be prompted to provide the password 

when opening the project in e-BRIDGE Role Manager.   
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2. Import Role Data 

 

Select the Import Role 

Data from File… to 

invoke the Windows File 

Open dialog.  

 

Figure 61. Import Role Data From File Menu Item 

 

 

From the File Open 

dialog, select the .xml file 

containing the user data 

previously exported from 

TopAccess. 

 

Figure 62. Browse for the Role .xml File 
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Check the Role or Group 

checkboxes in the 

Overwrite Roles/Groups 

window for overwriting 

Role or Group data in 

case of same name. 

 

 

 

 

 

Figure 63. Overwrite Roles/Groups window 
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3. Import User Data 

 

From the e-BRIDGE Role 

Manager Project Menu, 

select the Import User 

Data from File menu item 

to invoke the Windows 

File Open dialog. 

 

 

 

Figure 64. Import User Data From File Menu Item 

 

 

 

From the File Open 

dialog, select the .csv file 

containing the user data 

previously exported from 

TopAccess. 

 

Figure 65. Browse for the User .csv File 
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4. Discover Target MFPs 

 

 

From the Deployment Tab enter 

the IP Address range of the MFP 

you want to discover and click the 

Search button to start discovery. 

 

 

 Figure 66. IP Address Range for Discovery 

 

During Discovery, the device list 

will be populated, you can stop 

discovery by clicking the Stop 

Search link at any time.   

 

 

Figure 67. Deployment Tab- Discovery 
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5. Deploy Role Data to Discovered MFPs 

 

 

 

 

 

Select the MFPs for 

deployment. 

 

     

Figure 68. Deployment Tab – Fleet Selection 

 

Enter the User Name and 

Password of the target MFP(s).  

This is needed in order to update 

the MFP. 

 

Make sure to check Deploy User 

Counters to deploy all of the user 

counter data. 
 

Figure 69. Deployment Tab- Administrator 

Credentials 
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Click the Deploy button 

 

Figure 70. Deployment Tab- Deploy Button 

 

 

 

 

 

Deployment begins with dynamic 

Deployment Status Updates 

 

Figure 71. Deployment Tab - Status 
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Deployment Statuses 

MFP Status Column Description 

 Queued The system is gathering data and preparing the 

transmission.   

Canceled A queued item was canceled.   

 Transmitting The Role data is being sent to the MFP.   

Pending All the Role data has been received by the MFP and the 

MFP is processing the data.   

 Updated The data was successfully deployed and the MFP updated. 

 <Error Description > Unsuccessful Deployment.  A description will be provided 

when available.  Note that once the data has been received 

by the MFP, errors on the MFP side may not be reportable. 

 

 

It is important to make sure that the ODCA Settings in e-BRIDGE Role Manager 

and TopAccess are same for successful execution of Network Import method and 

deploying to the MFP.
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For hard drives, GB is equivalent to 1 billion bytes. 

Total hard drive accessible capacity may vary depending on operating environment. 

Design and specifications subject to change without notice. 
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